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File Manager Jr. gives you rapid access to files in all your favorite folders.  The 
program makes it easy to open, move, copy, delete, rename and print documents, 
and to perform many other operations.

Before using File Manager Jr. to gain access to a folder, you need to identify the 
folder so the program will be able to find it.  You perform this operation only 
once.  Files in the folder will be readily accessible thereafter.  For more 
information, see “Assigning folder names” on page 3.

Conventions used in this guide
Names of commands and command buttons appear in bold.  (Command buttons 
are sometimes referred to simply as “commands.”)  Examples of words to be 
typed by the user appear in lowercase bold.  Paths and filenames appear in sans 
serif.  Example:  C:\Apps\Word\Wombat.doc.

Names of keys appear in small capitals.  In typing instructions, the plus sign and 
comma have special meanings when used between names of keys.  A plus sign (as
in ALT+B) means that the first key is to be held down while the second key is 
pressed.  A comma (as in TAB, H) means that the first key is to be pressed and 
released before the second key is pressed. 

Starting the program
To make it easy to start File Manager Jr., you should assign the program to a 
shortcut key and/or toolbar button.  (Step-by-step directions appear in the 
Read_1st.fmj file.)
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When the program starts, you see the main menu.  One column of commands 
appears on the left and another on the right.  A Folder box appears at the center.  
The names in the box are faintly visible (as seen in the following example).

If you select a command in the left-hand column, the names in the Folder box 
come into sharp focus (as illustrated below).  You can then pick the folder in 
which you want to carry out the command you have selected.
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Commands in the right-hand column are enclosed in a free-standing box and 
operate independently, making no use of the Folder box.  If you select a command
button on the right, the specified command is set in motion immediately.

Assigning folder names
The first time you start File Manager Jr., the name “Main Word Folder” appears 
alone in the Folder box.  To gain access to additional folders, you simply add 
names to the Folder box.  Procedure:
Starting at the main menu, click the Setup button and then the Assign Folder 
Name button.  In the Assign Folder Name box, click a drive button to identify 
the drive containing the folder you want to assign.  A new box appears, displaying
the name of the drive.  Example: d:\.  After the drive name, type the rest of the 
path leading to the folder you’re assigning.  Here is an example of a completed 
path: d:\martha\memos.

After completing the path, press TAB to move to the lower part of the box.  Type a
brief descriptive name for the folder you’re assigning.  Example: martha’s 
memos.  Then press ENTER.  The program assigns the folder.  The descriptive 
name appears in the Folder box the next time the main menu is displayed. 

Note   Typing a descriptive name for a folder is optional.  After completing the 
path of the folder you want to assign, you can press ENTER without typing 
anything else.  If you do so, the program treats the folder path as a descriptive 
name and displays that path in the Folder box on the main menu.  Suggestion: 
Don’t omit descriptive names if you’re assigning folders with long paths.  A short
descriptive name is easier to read than a long path.

You can assign up to 100 folders.  Some can be subfolders of others.  Example: 
You can assign the folder C:\Docs and the subfolder C:\Docs\Biz, so that each will
occupy a separate line in the Folder box.  You can also assign a subfolder you’ve 
created on a disk in a floppy drive.  (But make sure the right disk is in the floppy 
drive when you try to gain access to the subfolder.)  If you have two hard drives, 
folders on both drives can be assigned. 

The descriptive name of the main Word folder always appears at the top of the 
Folder box.  Descriptive names of the folders you assign are arranged 
alphabetically below the name of the Word folder.  For uniformity, the program 
capitalizes the first letter of each word in each descriptive name.  (You don’t need
to use capitals when you type descriptive names.) 

If you want to remove a descriptive name from the Folder box, click the Setup 
button and then the Remove Folder Name button.  Follow the onscreen 
directions.  The Remove Folder Name command does not delete a folder.  It 
merely clears a name from the Folder box.  If you no longer need access to a 
folder, you can use the command to discard the folder’s descriptive name.
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If you want to change a descriptive name, click the Setup button and then the 
Change Folder Name button.  If you discover a typing error in one of your 
descriptive names, you can use the Change Folder Name command to correct the
error.  You can also use the command to replace a descriptive name if you think 
of a more suitable name.

If you try to gain access to a folder that has been deleted, renamed or moved, a 
message informs you that the folder cannot be found.  Use the Remove Folder 
Name command to discard the descriptive name associated with the folder. 

Note   If your computer is connected to a network, you may be able to use File 
Manager Jr. to gain access to folders on network drives—just as you gain access 
to folders you’ve created on local drives.  It may not be possible, however, to use 
certain File Manager Jr. commands on network drives.  Your network privileges, 
for example, may not extend to deleting or renaming files in some folders.

Performing common operations
Mouse   To open a file,  click the Open button on the left side of the main menu 
and then double-click a descriptive name in the Folder box.  A file list appears.  
Double-click a filename.

To move, copy, delete, rename or print a file, first click the appropriate command 
button in the left-hand column.  Then double-click a descriptive name just as you 
would if you were opening a file.

Keyboard   To open a file, first select the Open button by typing the letter O.  
Use the DOWN-ARROW key to highlight a descriptive name in the Folder box.  
Then  press ENTER.  A file list appears.  Highlight a filename and press ENTER.

To move, copy, delete, rename or print a file, first press a letter key to select the 
appropriate command button in the left-hand column.  Then choose a descriptive 
name just as you would if you were opening a file.

General   If you select a command button in the left-hand column and discover 
that you picked the wrong button, you can reselect.  Example: If you select the 
Delete button when you meant to select the Copy button,  just click Copy.  Or 
press ALT+C or TAB, C.  Alternatively, you can click the Home button to start 
over.  To choose the Home button using the keyboard, press ALT+H or TAB, H.

If the Folder box contains dozens of descriptive names and the name you want is 
buried in the list, try this: After selecting a command button in the left-hand 
column, type the first few characters of the descriptive name you’re looking for.  
Then tap the DOWN-ARROW key once.  The first name beginning with the 
characters you typed will be highlighted in the Folder box.  The name you want 
should then be within easy reach.

File Manager Jr. / 4



To gain access to a file on a disk in drive A or drive B, select a command in the 
left-hand column and then click a drive button.  To choose the Drive A button 
using the keyboard, press ALT+V or TAB, V.  To choose the Drive B button, press 
ALT+E or TAB, E.  (The Drive A and Drive B buttons give you direct access to 
files stored in the root directories of floppy disks.  A:\Wombat.doc, for example, 
would be in the root directory on A.  The files A:\SubDirOne\Aardvark.doc and 
A:\SubDirTwo\Platypus.doc would be in subfolders.  If you need regular access to
a subfolder on a floppy disk, assign the subfolder to the Folder box.  See page 3.)  

To execute one of the eight commands in the column on the right side of the main
menu, simply click a command button or press a letter key.  Example: To  execute
the Address Book command, click the Address Book button or press the A key.

Back buttons appear in many File Manager Jr. dialog boxes.  Clicking a Back 
button takes you back one step, closing a dialog box and redisplaying the previous
box.  To choose a Back button using the keyboard, press ALT+B or TAB, B.

Note    Because word processing is keyboard-intensive, using keystrokes to carry 
out commands is sometimes more efficient than using a mouse.  In the time it 
takes to reach for a mouse and click a button, you may be able to enter a half 
dozen keystrokes—without moving either hand out of typing position.  For that 
reason, several examples of keyboard operations appear earlier in this guide.  No 
keyboard directions appear in later step-by-step examples, or in most File 
Manager Jr. screen messages, but the directions are omitted for brevity only. 

The command list
Open   The command opens a previously saved file.

You can also use the Open command to see which files are in a given folder.  
After viewing the file list, click Cancel.

Move   The command transfers a file from one folder to another.  Procedure:
Click the Move button and then double-click the descriptive name of the folder 
containing the file you want to move.  In the next box, double-click the name of 
the file.  A Destination box appears.  Choose a destination by double-clicking the
descriptive name of the folder you want the file moved to.  Or, to move the file to 
the root directory of a floppy disk in drive A or drive B, click a drive button.

You can also move a file from a floppy disk.  Example: To move a file from the 
root directory of a floppy disk in drive A, first click Move and then click the 
Drive A button.  Pick a file, then a destination. 

You can usually move a file even if it’s open.  If you move the active document, it
is reopened at its new location after the move, unless you move it to a floppy disk.
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Copy   The command creates a duplicate of a file and sends the duplicate to a 
destination of your choice, leaving the original copy of the file in place.  The  
command is structurally similar to Move.

Delete   The command deletes a file.  By default, File Manager Jr. does not ask 
for confirmation before carrying out the command.  If you want to be asked, click 
the Setup button on the main menu and then click the File Delete Confirmation 
button.

You can usually delete a file even if it is open.

Note    You can restore files deleted with the Delete command.  For more 
information, see “The Trash Bin” later in this guide.

Kill Backups   The command deletes backup files in a selected folder.  Click the
command button and then double-click a name in the Folder box.

The command saves and closes all files before deleting backups.  If you have a 
non-backup file onscreen, it is reopened after the command has been carried out. 

You can’t use Kill Backups to delete backup files on floppy disks.  When you 
select the command button, the Drive A and Drive B buttons are unavailable.

Rename   The command changes the name of a file.  Pick a file as you would if 
you were using one of the commands described earlier.  When asked to enter a 
new name for the file, don’t type a path ahead of the filename.  Type the filename 
only.  Example: Type wombat.doc, not c:\docs\wombat.doc.  (If you type a 
filename without a one-to-three-character extension, a .doc extension is added.)

You can usually rename a file even if it’s open.

Print File   The command allows you to print documents without opening them.  
You can print any document in any folder identified by a descriptive name in the 
Folder box. After choosing a document to print, you can elect to print one copy of
the complete file, or to print multiple copies, or to print only certain pages.

Save New   Use the command to specify where a file will be stored when saved 
for the first time.  Example: If you have a new file onscreen and want to store it in
the main Word folder, click the Save New button and then double-click the 
descriptive name of the main Word folder.  When asked to enter a name for the 
new file, don’t type a path ahead of the filename.  Example: Type wombat.doc, 
not c:\program files\microsoft office\office\wombat.doc. 
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You can also use the Save New command to create a copy of a file under a new 
name.  Example: The file Able.doc is in the main Word folder.  With that file 
onscreen, you click Save New and then double-click the descriptive name of the  
main Word folder.  In the next box, you type baker.doc and click OK.  You now 
have two identical files—Able.doc and Baker.doc—in the main Word folder.  
Another example: Able.doc is again onscreen.  You proceed as before, except that
this time you double-click the second descriptive name in the Folder box.  Result:
Baker.doc is created in the second folder rather than in the main Word folder.  
Used this way, Save New is a cousin of the Copy command, which also copies a 
file from one folder to another, but without giving the copy a new name.

You can’t use the Save New command to store a new document on a floppy disk. 

Get Stats   The command displays statistical information about files in a 
specified folder.  After clicking the Get Stats button, double-click a descriptive 
name in the Folder box.  A list of files appears.  To view statistical information 
about a file, double-click a filename.  If you then want to see statistics for another 
file, double-click a second filename.

Back Up   The command sends a copy of the active document to a backup disk 
in drive A.  Any previous backup copy is overwritten.  If you have a drive B and 
want to use that drive for backups instead of the drive A, click the Setup button 
and then the Change Backup Drive button. 

Print Selection   The command prints a selected block of text.  First highlight 
the text you want to print.  Then click the Print Selection button.

File Info   The command displays a word count, a page count and other statistical
information about the active document.

Create Folder    The command makes a new folder.  When you click the 
command button, a Create Folder box appears.  Click a drive button to identify 
the drive where the new folder will reside.  A Folder Path box appears, 
displaying the name of the drive.  Example: c:\.  After the drive name, type a 
folder name.  Then click OK.

You can create a folder and one or more levels of subfolders at the same time.  
Example: If c:\one\two\three is entered in the Folder Path box, the program 
creates a C:\One folder, a C:\One subfolder called Two, and a C:\One\Two 
subfolder called Three.  (If C:\One already exists, only the two subfolders are 
created.  If C:\One\Two already exists, only the Three subfolder is created.)

You can also use the command to create a subfolder on a disk in a floppy drive.
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Address Book   The command gives you access to a list of addresses.  You can 
use it, for example, to copy addresses to letters and envelopes.  For additional 
information, see “More about Address Book” later in this guide.

Junk Closet   The command is used to store text temporarily in a holding file.  
For additional information, see “More about Junk Closet” later in this guide.

Quit Word   The command closes any open files and shuts down Word.  If any 
open files have been changed since they were last saved, the changes are 
preserved.  If you have entered text in a new document but have not yet named 
the document, you’ll be asked to supply a name before quitting Word.

The Trash Bin
Overview: Using the File Manager Jr. Delete command, you can delete files from
within Word instead of having to leave the program to delete them.  When files 
are deleted from within Word, Windows does not provide backup protection by 
sending the files to the Recycle Bin.  But File Manager Jr. allows you to protect 
such files by having them sent to a Trash Bin folder.  

If you don’t want to use the Trash Bin feature, skip the rest of this section, bearing
in mind that files deleted with the Delete command may then be irretrievable.

To create a Trash Bin folder that will protect deleted files, click the Setup button, 
then the Trash Bin button, then the Create Trash Bin button.  Follow the 
onscreen directions.  You can put the Trash Bin folder on any hard drive.  If the 
folder you want to use doesn’t exist, File Manager Jr. can create it.

When you delete a file, it is sent to the Trash Bin with an extended name that 
includes the date and time of the deletion.  A 24-hour time format is used.  
Examples: The date is August 1, 1997.  At 3:10:05 p.m. (or 15 hours, 10 minutes 
and 5 seconds on the 24-hour clock), you delete a file called Bluto.doc.  The file is
sent to the Trash Bin as Bluto.doc  08-01-1997  15.10.05.  The following day, at 
9:06:03 a.m., you delete another file called Bluto.doc.  That file is sent to the 
Trash Bin as Bluto.doc  08-02-1997  09.06.03.

You can quickly restore a deleted file.  Starting at the main menu, click the Trash
Bin button and then the Restore button.  A list of Trash Bin files appears.  
Double-click the name of the file you want to restore.  Then choose a destination. 
When a file is restored, the date-and-time stamp is removed from the filename.

You can discard Trash Bin files when you know you’ll have no further use for 
them.  Click the Trash Bin button and then the Discard button.  Files can be 
discarded individually or all at once.  Directions appear onscreen.

The Trash Bin does not capture files deleted with the Kill Backups command.
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If you’ve set up a Trash Bin folder and no longer wish to use it, click the Setup 
button, then the Trash Bin button, then the Remove Trash Bin button.  Do not 
use any other method to remove the Trash Bin.

More about Address Book
When you click the Address Book button, a dialog box displays seven command 
buttons.  The first button is Add Listing.

You use the Add Listing command to create address listings and add them to a 
file in which frequently used addresses are stored.  (The file is called 
Namelist.fmj.  It is placed in the main Word folder during installation of File 
Manager Jr.)  When you click Add Listing, an empty address box appears.  You 
type information in the box.  Here is an example of a completed box:

If you want to use a courtesy title such as “Ms.” or “Mr.,” place the title ahead of 
the first name.  In the Horatio Blunt address listing illustrated above,  “Mr. 
Horatio D.” could have been typed in the FirstName field in place of “Horatio D.”

If you want to use a middle name or middle initial, just add it to the FirstName 
field.  See the FirstName field in the Horatio Blunt listing.

If you want to use an abbreviation such as “M.D.,” “Esq.” or “Jr.” after an 
addressee’s name, place the abbreviation at the end of the LastName field.  See 
the Horatio Blunt listing.

You can skip some fields.  Example:  If you want to record a company address 
rather than the address of an individual, skip the first two fields and type the 
company name in the Organization field.
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If a listing includes a Salutation field, the text entered in that field is used as part 
of a salutation when the listing is copied to a letter.  The Horatio Blunt listing, for 
example, would be copied with a “Dear Mr. Blunt:” salutation.  If “Horatio” had 
been typed in the Salutation field instead of “Mr. Blunt,” the address would be 
copied with a “Dear Horatio:” salutation.

The Phone&Misc field is used to store telephone numbers and miscellaneous 
information.  The field accommodates about 250 characters.

The second command in the Address Book dialog box is Copy Address.  It 
places an address block in a business letter, saving you the trouble of typing an 
inside address.  To copy an address block, first place the insertion point anywhere 
on the top line of the body of your letter.  Click the Address Book button and 
then the Copy Address button.  When a new box appears, type a last name, a first
name or some other combination of characters known to be in the listing you’re 
looking for.  Then click OK.  The program searches for a listing containing the 
characters you typed.  If the first listing found is not the one you want, click the 
Skip This Listing button.  The program then searches for a second listing 
containing the characters you typed. (It is of course helpful to avoid typing a 
sequence of characters likely to be found in many listings.)

The third command in the Address Book dialog box is Print Envelope.  It works
much like the Copy Address command.  Have an envelope ready to print when 
you use the command.

By default, the Print Envelope command uses the Courier New font and does not
print a return address on envelopes.  To override either or both defaults, do this: 
On the main menu, click the Setup button.  In the Setup dialog box, click the 
Envelope Format button.  Select a font and a point size.  When asked whether 
you want a return address printed, click the Yes or No button.  If you click Yes, 
Word will use whatever address it finds in your Mailing Address box.  To see 
what’s in that box, first display the Tools menu in Word.  Click Options and then 
the User Information tab.

The fourth Address Book command is Delete Listing.  Use it when you want to 
remove a listing from the address file.  After clicking the Delete Listing button, 
type a name just as you would if you were using the Copy Address or Print 
Envelope command.  Then click OK.

The fifth command, View Listing, is used to look up information in an address 
listing.  Example: If you need Horatio Blunt’s street address, telephone number or
fax number, click the View Listing button and type horatio in the next box.  
Then click OK.

The sixth command, View All Listings, is also used to look up information.  
Unlike the previous command, which displays a single address record, the View 
All Listings command displays a file containing all your address listings.  After 
viewing the listings, you can close the file as you would any other—by clicking  
Close on the File menu or by clicking the lower of the two X buttons at the upper-
right corner of the screen.
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The last command in the Address Book dialog box is Fix Listing.  If you 
discover a typing error in one of your listings, you can use the Fix Listing 
command to correct the error.  (Do not try to correct a listing by editing the 
Namelist.fmj file.   You can open Namelist.fmj  to view its contents, but you can’t  
edit the file and then save it.  If you try, a message informs you that Namelist.fmj 
is a read-only file.  Should that message appear, press ESC twice and then close 
the file.)

A fictitious Horatio Blunt listing has been placed in the address file for 
demonstration purposes.  You can use the Horatio Blunt listing to experiment  
with the Copy Address command, and also with the Print Envelope, View 
Listing, Fix Listing and Delete Listing commands.

More about Junk Closet
The Junk Closet command is used to set aside text you want to remove from the 
active document but keep available for possible use later.

To store a block of text in the junk closet, highlight the text, click the Junk Closet
button and then click the Store Selection button.  The text is removed from the 
active document and sent to a file called Junk.fmj.  (The file is placed in Word’s 
main folder when you install File Manager Jr.)

To find text in the junk file, click the Junk Closet button and then the Open 
Closet button.  A Find box appears.  Type a word or phrase peculiar to the block 
of text you’re looking for.  Then click OK.   If the junk file is small and you don’t
need to do a search, click Cancel to close the Find box.

To retrieve a block of text from the junk file, highlight the text and place it on the 
Windows Clipboard.  Then close the junk file and paste the text into the active 
file.

Separator marks appear between blocks of text stored in the junk file so that you 
can easily tell where one block ends and the next begins.

To delete text from the junk file, open the junk closet, highlight the text you want 
to delete and press the DELETE key.  Then save and close the file.

File Manager Jr. and the Windows Clipboard
Occasionally, File Manager Jr. may clear the Clipboard while carrying out a 
command.  The Clipboard may be cleared because the program needs to use it for 
storage and retrieval of data while a command is being executed.  Or, 
infrequently, it may be necessary to clear the Clipboard to keep Word from 
misreading the status of a file.  You can still use the Clipboard for normal cut-
and-paste operations.  But if you cut a block of text and then execute a File 
Manager Jr. command without first pasting the block somewhere, the deleted text 
may no longer be retrievable.
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Starting File Manager Jr. automatically
If you want the File Manager Jr. menu to appear whenever you start Word, click  
the Setup button on the main menu and then click the AutoMenu button.  In the 
AutoMenu box, click the Enable button.  If the AutoMenu feature is switched on
and you want to switch it off, click Disable.

Uninstalling File Manager Jr.
1. In the main Word folder, delete Junk.fmj, License.fmj, Namelist.fmj, Read_1st.fmj 

and Tutor.fmj.

2. In the folder where Word templates are stored, delete Fmj.dot (if it has not already 
been removed).

3. On the Tools menu, point to Macro and then click Macros.  In the Macros  box, 
click Organizer.  In the list of Normal.dot macros, delete FileMgrJr, FileMgrJrAux 
and all macros whose names start with “Fmj.”
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